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1. WHAT IS DICE 

1.1. Introduction 

A relational database containing information extracted from the International Criticality Safety 

Benchmark Evaluation Project (ICSBEP) Handbook has been developed with a user interface that 

allows interrogation of the database. The database was first released with the 2001 Edition of the 

ICSBEP Handbook. The database and the corresponding user interface are referred to as DICE 

(Database for the International Handbook of Evaluated Criticality Safety Benchmark Experiments). 

DICE is maintained and upgraded on a continual basis and released annually with the Handbook. DICE 

allows simple or complex queries or searches on specific data and parameters of experimental 

benchmarks within the ICSBEP Handbook. A wide variety of searches can be performed, such as 

experiments performed at a specific facility or experiments matching select engineering parameters, 

e.g., the main components of a fuel-pin cell (type of fuel, cladding, moderator, and/or coolant). 

Additionally, global searches of all the experimental configurations containing any nuclide or isotope 

of interest can be performed using queries such as “Fuel region contains” and “Neutron Balance.” 

A very brief overview of DICE follows. A more complete description of the content and how to perform 

queries is provided in the Glossary (Section 11). It is a glossary containing all the terms used by DICE.1 

It provides the definition of each term and indicates where in the ICSBEP Handbook the data are 

obtained. This glossary is intended to assist the users of DICE not only with searches of the database 

but also with their interpretation of the parameters obtained by those searches. Furthermore, the 

clarification of the terms used by DICE will also assist benchmark evaluators, who are now required to 

enter select benchmark data into an Excel spreadsheet from which it will be automatically entered in the 

DICE database. 

Refinements and additions in both the content and search capabilities of the DICE database are ongoing. 

Comments, corrections and suggestions are always welcome and can be forwarded to dice@oecd-

nea.org. 

1.2. What’s new 

The database content has been revised and approved evaluations in 2021 have been incorporated.  

                                                      

1 The Glossary only addresses the terms contained in the Critical / Subcritical Search pane of DICE. 

mailto:dice@oecd-nea.org
mailto:dice@oecd-nea.org
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2. QUICK START 

In order to use the DICE tool and access the DICE database, you must: 

 Have the DVD containing DICE in order to run DICE directly from the DVD or add DICE to 

your computer as instructed below; 

 Have Java 8 or newer installed on your computer or add it as instructed below; 

 Have a large screen; a minimum resolution of 1024×768 is recommended. 

2.1. DICE 2021 DVDs Contents 

ICSBEP 2021 Edition contains two DVDs.  

The DVD #1 contains the following directories and files for DICE installation and operation, as well as 

the “DiceData” folder that contains the calculated data: 

 Root directory contains this user’s manual; 

 Directory “CD2021”: contains the ICSBEP Handbook; 

 Directory “Dice”: contains dice.bat and dice.sh batch command files; 

 Directory “DiceData\balance”: contains neutron balance files; 

 Directory “DiceData\sensitivity_binary”: contains NEA sensitivity files and 

corresponding input files for SCALE 6.0, 6.2beta and MCNP6 that have been translated into an 

efficient binary format to increase the speed of DICE calculations with these files; 

 Directory “DiceData\newE”: contains energy group structure files; 

 Directory “DiceData\spectra”: contains spectra files; 

 Directory “Dice\databases”: contains the H2 local database; 

 Directory “Dice\software”: contains the DICE software; 

 Directory “Plugins”: contains DICE plugins (e.g. ORNL VIBE tool). 

 

The DVD #2 contains supplemental data for two evaluations: 

 FUND-NCERC-PU-HE3-MULT-001 

 FUND-NCERC-PU-HE3-MULT-002 

As well as sensitivity data in text format, a majority of which is SDF.  

 Directory “DiceData\sensitivity”: contains NEA sensitivity files and corresponding input 

files for SCALE 6.0, 6.2beta and MCNP6; 
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 Directory “DiceData\ornl”: contains ORNL TSUNAMI-3D-K5 and TSUNAMI-3D-K6 

sensitivity profiles and corresponding input files for KENO V.a and KENO VI; 

 Directory “DiceData\ippe_sensitivity”: contains IPPE sensitivity files; 

2.2. DICE Installation (Optional) 

You can run DICE directly from the DVD or copy the entire “Dice” folder contents onto your hard 

drive.  This requires approximately 114 MB. The “DiceData” folder is 3.9 GB and can be copied as 

well or its content can be accessed from the DVD. 

2.3. Java Installation 

If Java 8 or newer is already installed on your system, skip Section 2.3 and proceed to Section 2.4.  

Java can be downloaded from https://adoptopenjdk.net/ or from Oracle’ websites: http://www.java.com/ 

or http://www.oracle.com/technetwork/java/javase/downloads/index.html. 

Note: Java for Mac OS X users is provided by Apple. 

2.4. Launch DICE 

DICE can be launched by using the dice.bat (for Windows) or dice.sh (for Linux/UNIX) 

executable scripts available in the “Dice” folder. For Macintosh users, the folder mac_os_x contains a 

Mac OS X bundle. 

However, if you wish to use VIBE as a DICE plugin, use these executable scripts instead: vibe-

dice.bat (for Windows) or vibe-dice.sh (for Linux/UNIX). 

Once you launch DICE, a Disclaimer window will appear before the main DICE window appears. 

Note:  Plugins currently share the connection to the same “LocalShared” database. This database is the 

H2 database provided on the DVD which must be copied on a local hard drive (The database 

management system needs to create files to share the connection between DICE and any plugin). 

https://adoptopenjdk.net/
http://www.java.com/
http://www.oracle.com/technetwork/java/javase/downloads/index.html
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3. GENERAL OVERVIEW 

The first screen of the user interface is the “Search” window, which is shown in Figure 1. 

The DICE main window is composed of six main panes: 

1. Critical / Subcritical: searches through all of the critical and/or subcritical experiment cases 

(Volumes I-VII) of the Handbook; 

2. Alarm / Shielding: searches through all of the alarm and/or shielding measurement cases (Volume 

VIII) of the Handbook; 

3. Fundamental Physics: searches through all of the fundamental physics measurement cases (Volume 

IX) of the Handbook; 

4. Correlation Matrix: displays correlation coefficients for criticality evaluations; 

5. Rank Similar: compute distances between user input and database content; 

6. keff trend plots: displays averaged C/E values, by various categories.  

As noted, only terms in the Critical / Subcritical pane are presently discussed in the Glossary. 

The “File” menu allows you to: 

 Export DICE results tables/plots into files; 

 Open a file from the ICSBEP Handbook (evaluation PDF, spectra PDF or balance file); 

 Open the Settings dialog; 

 Check if an update is available (requires an Internet connection); 

 Exit the software. 

The “Database” menu allows you to switch databases: 

 “Local”: the local database provided on the DVD; 

 “LocalShared”: the local database, ready to be shared with DICE plugins; 

 “NEA”: the NEA master database that can be updated after the DVD has been released. 

The database menu is dynamically updated to display the selected database name. 

The “Personal_Keff” menu allows you input your own keff calculation values: 

 “Load values”: Add user keff calculations to a local copy of the database. Only useable if DICE 

is copied from the DVD onto a local computer. For the user to load their own data, the following 

information is required: Evaluation Id, Case Id, Benchmark Model, Code, Library, Calculated 

Keff, Calculated Keff uncertainty. An example is shown below. 
PU-MET-FAST-042, 001, Simplified Model, KENO, ENDF/B-VI.8 Continuous, 
1.01282, 0.00010 



NEA/NSC/DOC(95)03/II 

DICE: User's Manual 

 

Revision:  11 Page 8 of 56 
Date:  September 30, 2021 

 “Export values to file”: export all previously loaded calculation values to a tab separated file; 

 “Clear values”: reset database content by removing all previously loaded personal values. 

Note: To successfully update DICE, DICE needs to be copied on a local folder in order to create new 

files containing updates. 

The “Window” menu allows you to ‘clone’ a DICE window. 

3.1. Critical / Subcritical Pane 

 

 

Figure 1: Critical / Subcritical Pane. 

This pane provides you with various data and/or parameter search criteria (e.g. fissile material, evaluator, 

geometry, etc.) allowing you to search for specific critical and/or subcritical cases using your search 

criteria (Volumes I,II,III,IV,V,VI and VII of the ICSBEP Handbook).  The search criteria are explained 

in detail in the Glossary. 
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3.2. Alarm / Shielding Pane 

 

Figure 2. Alarm / Shielding Pane. 

This pane provides you with various data and/or parameter search criteria (e.g. source, evaluator, 

detector type, etc.) allowing you to search for specific alarm and/or shielding cases using your search 

criteria (Volume VIII of the ICSBEP Handbook). (As noted, only terms in the Critical / Subcritical pane 

are presently discussed in the Glossary.) 

3.3. Fundamental Physics Pane 

 

Figure 3. Fundamental Physics Pane. 

This pane provides you with various data and/or parameter search criteria (e.g. source, evaluator, 

detector type, etc.) allowing you to search for fundamental physics cases in regards to your search 
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criteria (Volume IX of the ICSBEP Handbook). (As noted, only terms in the Critical / Subcritical pane 

are presently discussed in the Glossary.) 

3.4. Correlation Matrix Pane 

 

Figure 4. Correlation Matrix Pane. 

This pane provides you with data indicating if the uncertainty in two criticality cases are correlated and 

to which degree (coefficient between 0 and 1000) or if the nuclear data sensitivity vectors are correlated 

(between -1000 and 1000); the correlation displayed depends if ‘Uncertainties’ or ‘Sensitivities’ is 

selected A pop-up displays the unscaled value, when the cursor hovers over the value. 

See Section 6 for a description of this feature.   

Note:   Only limited correlation coefficient data of uncertainties are currently available.  These data 

were derived from IPPE and from ANL for the ZPR/ZPPR values. 
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3.5. Rank Similar Pane 

 

Figure 5. Rank Similar Pane 

The Rank Similar pane allows users to rank benchmarks based on 3 group fluxes, neutron balance, or 

sensitivity data. 

See Section 7 for a description of this feature. 
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3.6. keff trend plots Pane 

 

Figure 6. keff trend plots Pane. 

This pane gives an overview of the trends in C/E within the database for a particular measurement. The 

intent is to allow the user to see the overall information content in the database and apply user friendly 

filters to ‘drill down’ to a particular data set. 

See Section 3.6 for a description of this feature. 
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3.7. Customizing DICE 

 

Figure 7. Settings Dialog 

Once the DICE DVD is inserted or DICE is available on your computer, Java is installed and available, 

and DICE is launched, you may be required to customize DICE to operate properly on your computer.  

This can be done by opening the Settings dialog by selecting the menu “File > Settings…”. 

This dialog allows you to set: 

 Change the maximum number of rows that a search can return 

 Add advanced controls that impact what is returned from searches  

 The ICSBEP Handbook folder location; 

 The PDF viewer executable file to use; 

 The HTML viewer executable file to use; 

 HTTP Proxy information (host, port, and credentials); you must restart DICE for this setting to 

take effect.  

Note:  If you run DICE on Microsoft Windows, the PDF and HTML viewer settings should not need 

to be set. When these settings are left empty, DICE will launch your default PDF and HTML 

viewers. 

Note:  DICE settings are stored in a plain text file located under your personal documents folder 

(%USERPROFILE% under Windows); named dice_2_7_settings.txt. To reset the settings 

to the default values you can delete this file while DICE is not running. 
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Note: If you run DICE on Linux operating system, make sure to have installed a PDF viewer such as 

Adobe Reader, Evince or Okular. Then fill in the PDF viewer box with the path to one of this 

program e.g. /usr/bin/evince 

 

3.8. About DICE Dialog 

 

Figure 8. About DICE dialog. 

If you would like to view this information, open the About DICE dialog by selecting the menu 

“Help > About DICE”. 

This dialog shows summary information about the DICE version, Java version, operating system, and 

network settings that you are currently using. This information should be transmitted to the DICE 

developers if you report a problem or submit an enhancement request (use the “Copy messages” button 

to copy this information to the clipboard). To contact DICE developers you can also send an e-mail to 

dice@oecd-nea.org. 

mailto:dice@oecd-nea.org
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4. SEARCHING 

DICE allows you to search the Handbook for particular evaluations. The three panes 

“Critical / Subcritical”, “Alarm / Shielding” and “Fundamental Physics” work the same way. 

4.1. Setting Search Criterion 

The list or tree in the far left side of the main window presents the available search criteria grouped into 

“Themes.”. The right panel(s) of the window displays the selected theme control panel(s). The four main 

types of search criterion are described below. 

4.1.1. Selection List 

 

Figure 9. Selection List criterion. 

Select one or more items from the list.  

Note:  You can use the CTRL or SHIFT keys to select multiple items. 

The first item, “None selected”, can be used to unselect all highlighted items. 
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Some theme criteria can have multiple values for a given ICSBEP evaluation or cases within an 

evaluation (e.g. moderator material).  In these instances, you can search evaluations by selecting: 

 Any of your choices with the “OR” button; 

 Or all of your choices together with the “AND” button. 

These two buttons remain grayed-out until you select more than one item from the list (“OR” is the 

default). 

For example, by selecting “Lucite” and “Water (Light Water)” in the moderator/coolant materials list 

and leaving the default “OR” button, you will find the ICSBEP evaluation cases having “Lucite” or 

“Water (Light Water)” or both as moderator/coolant material.  If you select the “AND” button, you will 

only find those evaluation cases that have “Lucite” and “Water (Light Water)”. 

If the filesettings advanced controls checkbox is selected, beside the “AND/OR” buttons a 

checkbox labelled “Show all elements from matched cases ids” will appear. This allows the user to 

return all information from the matching cases, rather than just the matched criteria. For example if a 

search is done for cases sensitive to H1 capture OR Al27 capture, normally only the H1,Al27 capture 

values would be accessible in the results panel. If the “Show all elements from matched cases ids” will 

return the full sensitivity profile from the matched cases. 

4.1.2. Numerical Values 

 

Figure 10. Numerical Values criterion. 

You can search for numerical values in two ways: 

 For a specific value with an optional accuracy, the accuracy has to be input as a percentage of 

the specified value (e.g. “75” with an accuracy of “10” would search for values between 68.5 

and 82.5). 

 For a range of values, specify a minimum and/or a maximum value. If you specify an upper 

value that is less than the current value, the criterion is not set. 

You can enter a numeric value in scientific notation (e.g. 1E3 means 1000). Also searches can be done 

using the absolute value of the numerical values (option available for sensitivities coefficients – an 

addition Abs checkbox is displayed). 

Note:  If a numeric value is invalid, it is displayed in white on a red background (e.g. you cannot add 

a percent sign [%] in the accuracy field). 
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4.1.3. Text Fields 

 

Figure 11. Text criterion. 

Text searches may be performed by selecting “Title”, “Keyword”, or “Reference” under the General 

Items tree structure. Keyword searches are limited to the list of Keywords provided in each ICSBEP 

evaluation report.  To search on text, first choose the operator in the drop-down: 

 Contains; 

 Does not contain; 

 Begins; 

 Does not begin; 

 Ends; 

 Does not end; 

 Equals; 

 Does not equal. 

Then, enter a word or part of a sentence in the text field. This criterion also supports a wildcard character 

(‘%’). 

If you wish to perform a case sensitive search, check the “case sensitive” box. 

Note:  You can search for Unicode characters as they appear in titles and references (e.g. some Russian 

references are spelled in Cyrillic in the database). 
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4.1.4. Hierarchical Field 

 

Figure 12. Hierarchical criterion. 

You can select one or more items from the selection lists within a tree. 

Selecting a parent node of a tree is equivalent to selecting all of its children nodes within a tree (e.g. by 

selecting “France” in the Laboratory tree, the database searches for all experiments performed in 

“Cadarache”, “Saclay” or “Valduc”). 

4.2. Query Panel 

 

Figure 13. Query Panel. 

The query pane located at the bottom of the screen displays the criteria currently set and the columns 

selected in the results window. 

You can remove a criterion by selecting it and pressing the DEL key.  The “Clear” button removes all 

selected criteria. 
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You can remove a checked results columns directly from this window by selecting it and pressing the 

DEL key. 

Each time you add, change, or remove a criterion, the status bar is updated to display the number of 

evaluations and cases found in the database matching the current selected criteria. 

Once the search criteria have been selected, run the query by clicking the “Search !” button. This will 

display the “Results” view. 

Note:  The “History” drop down list displays the 10 most recent executed DICE queries. To recall a 

previous query, select it from the list and all search criteria will be automatically set to match 

the previous search. 
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5. DISPLAYING RESULTS 

 

Figure 14. Results Window. 

Several views are available for displaying search results, you can switch between them by using the 

toolbar buttons (1 in Figure 14): 

 Flat table; 

 Hierarchical tables (horizontal or vertical split); 

 Scatter plot; 

 Parallel axis plot. 

Use the left tree to select the result tables/plots columns (2 in Figure 14). After making changes, press 

the “Apply” button (3 in Figure 14) to refresh the result views. The “Apply” button is enabled whenever 

a new result column is added/removed. Selected result columns are displayed in bold. 

To return the initial search pane, you can press either the ‘Refine search’ button, which retains the 

selected columns and search criteria, or the ‘New search’ button which will start a blank new search 

(that is, with no search criteria and with only the Title, Number of cases and Case label columns selected 

for results display). (4 in Figure 14). 
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In order to enlarge the space available for the result views you can hide this tree by clicking on the 

“Select” button. 

Note:  You cannot uncheck the Identification column.  A computed column (# cases) that displays the 

number of cases matching the query is automatically added. 

5.1. Results Tables 

To sort data, click on the desired column’s header. To reverse the sort order, press the SHIFT key while 

clicking on the desired column header. 

You can remove row(s) from the tables by selecting them and pressing the DEL key or by right-clicking 

the mouse to display the contextual menu and then selecting “Remove selected row(s)”. To restore the 

initial search results, press the “Apply” button.  

You can copy selected row(s) from the results tables and paste them into your text editor or Microsoft 

Excel. 

You can reorder the results tables’ columns. To do so, click on a column header and drag the mouse to 

the desired location. 

 

5.1.1. Hierarchical Results Tables, Horizontal Split 

This view is made of two tables separated by a vertical bar. In the left pane, the evaluation level columns 

are shown. In the right pane, the case level columns are shown. 

The right table (case level) displays the cases for the selected evaluations in the left table or all of the 

cases if none are selected. 

5.1.2. Hierarchical Results Tables, Vertical Split 

This view is the same as hierarchical results tables, horizontal split, except the tables are split by a 

horizontal bar. 

5.1.3. Single Result Table, Flat View 

In this mode, all columns are displayed in a single table. 
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5.2. Results Plot View 

 

Figure 15. Results Plot View. 

In order to plot certain data, you can select “X axis”, “Y axis” and “Series” among the selected results 

columns (see Section 5.1).  At least one numerical column needs to be available in order to obtain plots. 

The text columns (e.g. “References”) cannot be used in plots but all others can, except for the “Y axis”, 

which requires a numerical column (e.g. “Number of cases”).  For example, you can plot “Calculated 

Keff” (Y axis) against “Fuel concentration” (a numerical column) but also against “Library” or 

“Codename” (short text columns). If either ‘Benchmark Keff’ or ‘Calculated Keff’ are selected for 

plotting then uncertainty bars can also be plotted by checking the ‘errors’ checkbox.  

By right-clicking on the plot, a contextual menu allows you to: 

 Set some plot properties (title, legend, ticks); 

 Save the plot in a file; 

 Print the plot; 

 Zoom in or out. 

You can also use the mouse to zoom in by pressing the left button and then dragging the mouse from 

the top-left to the bottom-right corner.  To reset the zoom level, drag the mouse from the bottom-right 

to the top-left. 
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To display the data values corresponding to each point, hover the cursor over it to display a tooltip 

showing its coordinates. 

Note:  The legend is not displayed when there are more than 20 items to show. Press the “Select” button 

to enlarge the plot window. 

 

5.3. Parallel Axis Plot View 

 

Figure 16. Parallel Axis Plot View 

Parallel Axis Plots allows visualizing the relationship between DICE database values. 

Search results table columns are represented as vertical axes. For each results table row a polyline links 

its values on each axes. See http://en.wikipedia.org/wiki/Parallel_coordinates for a longer description. 

The checkboxes at the bottom allow selecting the search results columns which should be displayed as 

vertical axes. 

Numerical fields and classification fields (e.g. Fuel form, Moderator...) can be displayed by this 

visualization, text ones (e.g. Title) cannot be selected, by default only the first result table columns are 

initially selected. 

http://en.wikipedia.org/wiki/Parallel_coordinates


NEA/NSC/DOC(95)03/II 

DICE: User's Manual 

 

Revision:  11 Page 24 of 56 
Date:  September 30, 2021 

You can drill down in the values in two different ways: 

 By zooming a given vertical axis : click and drag in the yellow background area or a vertical 

axis; 

 By limiting the range of values displayed for a given axis: click on the upper/lower axes triangle 

and drag them to define a range, the polylines of the search results with value in this range only 

will be displayed. 

Note: 

 Axes can be reordered by clicking and dragging their titles, this is the most efficient way for 

revealing trends; 

 Axes can be moved left and right in their vertical band : click on axis and drag it; 

 The polyline segments colors express their weight, that is the number of cases that a given 

segment represent, the color scale used is the light spectrum from blue (low weight) to red (high 

weight), in current implementation the segments are not drawn in increasing weight order, so 

small weight ones may obscure the greatest ones; 

 Double clicking on polylines will switch into a mode where all will be drawn in black and the 

one near the location you double-clicked will be highlighted in red; 

 Plots must be saved by the ‘File > Save As…’ menu item; 

 A contextual menu is available with a right click on the plot: 

o 'Intensity mode' controls the polylines coloring scheme; 

o 'Make uniform'/'Make all uniform'/'Reset positions' controls the distribution of 

numerical values along axes : according to their magnitude (the default) or evenly 

spaced ('uniform'); 

o 'Selection dialog' bring a dialog which allow highlighting some of the results (by 

selecting row(s) in the table popup); 

o 'Column role', 'Column axis dimension', 'Clear all column axes' options have no effect 

in DICE. 

5.4. Evaluation PDF from the Handbook 

After having selected a single evaluation level row, press the “PDF” button in any results table view to 

open the PDF file containing the evaluation from the Handbook (5 in Figure 14).  

When an evaluation is part of a cross-references group, the user has the possibility to directly open the 

main evaluation PDF file. 

Note:  If the selected evaluation does not open, DICE was probably not able to find your default PDF 

reader, and you need to specify its location in the Settings dialog (see Section 3.7). 
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5.5. Evaluation/Case Summary in HTML 

After having selected a single evaluation or a single case in any of the results tables, press the “HTML” 

button (5 in Figure 14) to open an HTML file displaying a summary of either the selected evaluation or 

the selected case. 

Note:  If a browser does not open, DICE was probably not able to find your default browser, and you 

need to specify its location in the Settings dialog (see Section 3.7). 

5.6. Calculation Files 

To open a calculation file, double click on Balance, Input, Sensitivity or Spectra blue item. For these 

items to appear in results tables, the corresponding result columns under "Calculation Files” must be 

checked. 

Note:  Neutron balance data are currently available for about 92% of the available configurations in 

the ICSBEP Handbook. 

5.7. Spectra and Sensitivity Plots 

 

Figure 17. Sensitivity Plot. 

DICE can plot spectra and sensitivity data for criticality cases.  Click on the “Spectra plots” or 

“Sensitivity plots” buttons. 
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Select the dataset(s) in the tree on the lower right pane (1 in Figure 17). 

Then, select the representation (2 in Figure 17): 

 Y axis log (for Spectra only); 

 Per unit lethargy bin/Total within bin/Per unit Energy; 

 Normalization: to one or the entire reaction rate (for Spectra only); 

 Energy Group structure: select one structure from the drop-down list, press the “…” button to 

add an energy file to this list (3 in Figure 17); 

 The width of the lines can also be increased (7 in Figure 17); 

 Black & white : allows switching between colored plain lines and dashed black and white lines 

(8 in Figure 17) 

All data share the same representation.  When you change the energy group structure, all plots and the 

table are automatically updated. 

To zoom in, drag the mouse from the top-left corner to the bottom-right corner.  To reset the plot to its 

initial zoom level, drag the mouse from the bottom-right corner to the top-left corner. 

You can switch between the plots and a tabular display by using the buttons “Plots” and “Table” (4 in 

Figure 17). 

When two data are selected you can plot the ratio or difference in a bottom panel with the “Comparison” 

radio buttons (9 in Figure 17) 

Click on the “Clear” button to remove all plots and empty the table (5 in Figure 17).   

Click on the “Load own data…” button to add a curve from a file (6 in Figure 17).  

A sensitivity file must be in any of the following formats in order to plot: 

 ABBN sensitivity format; 

 MCNP6 output file; 

 TSUNAMI1D; 

 TSUNAMI3D;WPEC SG33 

Check the corresponding button in the Open file dialog before pressing the OK button. If the format is 

not known leave the default option “Auto-detect” selected. 

Note:  Spectra data are currently available for only about 92% of the available configurations in the 

ICSBEP Handbook. 

Note:  IPPE sensitivity data are currently available for only about 6% of the available configurations 

in the ICSBEP Handbook (in Volumes I and II). 
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Note:  ORNL sensitivity data are currently available for only about 11% of the available configurations 

in the ICSBEP Handbook (mainly in Volumes V and VI). 

Note:  NEA sensitivity data are currently available for only about 85% of the available configurations 

in the ICSBEP Handbook). P1 elastic data are available for only 711 cases, and has been set to 

zero below 52 keV. 

5.8. Exporting Results 

5.8.1. Clipboard 

The DICE results tables can be copied to the clipboard by using the CTRL-C or CTRL-INS keys.  

Results can be pasted into Microsoft Word (as a formatted table) or Excel (as table cells) or any other 

text editor or spreadsheet program. 

5.8.2. Files 

The menu “File > Save As…” can be used to save tables or plots. 

Plots can be exported as Portable Network Graphics (PNG) files. 

Tables can be saved as “tab delimited” (convenient for Microsoft Excel or any other spreadsheet 

program) or “Comma Separated Values” (CSV) files. 

Use the export dialog to set the delimiter: 

 Tab; 

 Semicolon; 

 Comma; 

 Other (type a delimiter in the box below). 

Then set the encoding: 

 ASCII (non-ASCII characters will be converted, e.g. ‘δ’ will be converted into ‘delta’); 

 Unicode (no conversion of characters). 

 

5.8.3. XML 

To generate an XML file containing the Keff values and associated nuclear code and data library press 

the XML button. This file is compatible with Nuclear Data and Sensitivity Tool (NDaST). Note that no 

result column needs to be selected for the export to work. The file paths contained in this XML file point 

to the files stored in the DiceData\sensitivity folder of the DVD #2.  
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6. CORRELATION MATRIX PANE 

 

Figure 18. Correlation Matrix Window. 

The correlation matrix window is split into two panes. The left pane allows you to select the correlation 

matrix to display (1 in Figure 18) and narrow the display by evaluation IDs or by nuclear facilities. The 

right pane displays the correlation matrix. 

You can choose to cluster the matrices according to a hierarchical clustering method (a variation of 

UPGMC, see https://en.wikipedia.org/wiki/Hierarchical_clustering) (2 in Figure 18) 

You can display certain parts of the correlation matrix by filtering on the following criteria: 

 Evaluation identification: the three drop-down menus on the upper left (2 in Figure 18); 

 Country/facility by using the tree (4 in Figure 18); 

 Cross-references: check or uncheck the “Show cross-references” check box. 

At the evaluation level when correlations of uncertainties is selected, the matrix cells will have the 

following attributes: 

 Empty when there is no correlation; 

https://en.wikipedia.org/wiki/Hierarchical_clustering
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 A “+” sign to indicate correlation; 

 A “(+)” symbol to indicate a 100% correlation; 

 Teal when there are case level data available, or bright blue otherwise. 

Note:  The “(+)” symbol appears outside the diagonal when an evaluation has more than one identifier 

in the ICSBEP Handbook (i.e. is a cross-reference). 

At the evaluation level when correlations of sensitivities is selected, the matrix cells will have the 

following attributes: 

 Empty when there is no correlation; 

 A numeric values between -1000 and 1000 displaying the evaluation level correlation which is 

just the average of the case level correlations between the evaluations. 

Note:  Due to the definition above, evaluations often do not have a correlation value of 1000 with 

themselves. This is because all correlations analysis should be done at the cases level, and the 

evaluation level provides an overview of case level data. 

 

At the case level, the matrix cells may be: 

 Empty when there is no correlation or the correlation coefficient is not known; 

 Colored with shades of green, darker green being closer to 1000. 

To switch between evaluation and case levels click the “Show cases level details” at the top of the matrix 

window and “Return to evaluations level” buttons (5 in Figure 18). 

When no correlation coefficients (cases level) are available in the database, the message “Sorry, no 

case/case correlation coefficients available...” is displayed. 

Note:  You can select multiple cells by holding the CTRL key while selecting cells or dragging the 

mouse to select a sub block from the matrix. 
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7. RANK SIMILAR PANE 

 

Figure 19. Rank Similar Pane 

The Rank Similar pane allows users to rank benchmarks based on 3 group fluxes, neutron balance, and 

sensitivity data. 

The pane applies a cosine similarity (https://en.wikipedia.org/wiki/Cosine_similarity) metric to the 3 

group flux, capture, fission, neutron balance, or sensitivity data, and returns a sortable list with the case 

identifier, code, library and ranking. The rankings are normalised on a scale where the most similar 

system is given a numerical value of 1, and the least similar is assigned a value of 0. An example of a 

search where the user inputs the percentage of fissions in 3 groups is shown in Figure 19. 

Cases that do not have calculated spectra data (approximately 8% of cases) can be returned in the list 

using the check box, ‘Show cases with no data’. The similarity is left blank for these cases. 

Where p is system one, q is system two. For multi-group fission, N is the percentage of fission in each 

group, while for neutron balance, N is the capture, and fission for each element, except that for fissile 

elements the distance is by isotope. 
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8. KEFF TREND PLOTS PANE 

 

Figure 20. keff trend plots example 

Bars Correspond to Average Values: 

Each red bar represents an average value. To display additional information about the number of points 

used in the average or the value and standard deviation, hover the cursor over the bar. The averaging for 

each bar can be performed via four methods using “Averaging” drop down box. Each option is briefly 

explained below. 

In all formula, N is the points at which both a C and an E value exist.  

ARITHMETIC  

∑ 𝐶𝑁/𝐸𝑁𝑁

𝑁
 

GEOMETRIC [4] 

(∏
𝐶𝑁

𝐸𝑁
𝑁

)

1
𝑁

 

In the case of a negative C/E, the geometric mean is calculated by separating the positive and negative 

components, computing the geometric mean of each, and then computing a weighted average of the two 

geometric means, where the average is weighted by the number of data points [5]. 
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WEIGHTED BY VALUE 

∑ 𝑊𝑁𝐶𝑁/𝐸𝑁𝑁

∑ 𝑊𝑁𝑁
 

With W 

𝑊 = 0.5 × (𝐶𝑁 + 𝐸𝑁) 

WEIGHTED BY UNCERTAINTY 

∑ 𝑊𝑁𝐶𝑁/𝐸𝑁𝑁

∑ 𝑊𝑁𝑁
 

With W 

𝑊 =
1

𝜎2 

where 

𝜎2 = 𝜎𝐸
2 + 𝜎𝐶

2 

Uncertainty associated with each bar from averaging of multiple data points: Standard deviation 

bars 

The standard deviation uncertainty line corresponds to the standard deviation of all C/E values within a 

data set. In Figure 20 for example, in the HEU column the standard deviation marker is the standard 

deviation of all C/E’s for HEU cases. 

Correlations should be taken into account; however there is not sufficient information within the 

database to include correlations at this point.  

Note: The user will encounter E.Std dev and E. Uncertainty RMS. The first occurs when multiple 

models have been collapsed, and the value represents the standard deviation of the benchmark 

experimental model keff. The second is not an RMS in DICE, it is simply the benchmark model 

uncertainty, while C.Uncertainty RMS is simply the uncertainty in the calculated keff. 

Reduced Chi-Squared Value 

 

In each trend plot the user can choose to display the reduced chi-squared value, which is a metric 

indicating the performance of the computed averages. Based on whether the user selects points or bars, 

the goodness of fit of the overall average, or the categorical averages can be displayed. If the reduced 

chi-squared value is high, then C/E values are fluctuating more than the uncertainty of the benchmarks 

within the categories. 

 

The equation computed is: 
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𝜒𝑟𝑒𝑑
2 =

1

𝑣
∑

(
𝐶𝑛
𝐸𝑛

− 𝜇)
2

𝜎𝑛
2

𝑛

 

 

Where 

 

𝜇 is the computed average, either the overall average of all points, 𝑛, or the average within each 

category; with the radio button points corresponding to the former and bars to the later. 𝜐 corresponds 

to the number of degrees of freedom. When the radio button ‘points’ is selected, the number points 

minus 2, while if bars is selected than it is the number of points minus the number of bars minus 1. 

Plots with Multiple Levels 

In the plot options two levels of detail can be selected. The first controls the values that will be plotted 

on the x-axis; the second level controls the number of bars in the first level, each with a distinct colour. 

The blue band uncertainty is the combination of the E. Uncertainty RMS (benchmark uncertainty) and 

C.Uncertainty RMS (calculated uncertainty). When collapsed over multiple evaluations or cases, the 

RMS of all the collapsed cases is calculated.  

Filters/Sorting 

Specific data can be selected by applying combinations of the filters present on the left. Additionally 

results can be filtered by the ‘Rank Similar’ criteria, so that the plots will only display cases within the 

selected range of similarity. 

Plots can be sorted by from low to high, or from high to low, alphabetically based on group label, the 

number of points within a group. Additionally numeric data from ‘Rank Similar’ or from the calculated 

data stored in the database can be used to sort the plot. When the data does not exist, it is given a default 

value of 0.0. 

Note: If the user unchecks all boxes no filter is applied, since otherwise the results would be empty. 
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9. PLUGINS 

 

Figure 21: VIBE Pane 

9.1. Introduction 

DICE enables the integration of third party tools (plugins). Each plugin is displayed in its own tab 

allowing users access to the plugin functionality without exiting DICE or launching both tools. 

A Java API is also available for developers wanting to programmatically retrieve data from DICE 

database from their tools. Contact NEA for more details: dice@oecd-nea.org.  

9.2. VIBE 

VIBE is a graphical user interface created to identify and interpret sensitivity data from 

SCALE/TSUNAMI that is distributed with SCALE 6.0. It enables users to: 

 Group collapse sensitivity data; 

 sort and filter the collapsed data so as to identify important processes in applications or 

experiments; 

mailto:dice@oecd-nea.
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 Provide an improved means of preselecting experiments for use in criticality code validation.  

VIBE also enables users to query the DICE database to gain more information about experiments present 

in the database. VIBE also supports other sensitivity data distributed with the 2014 release of the 

ICSBEP Handbook.  

To use VIBE as a DICE plugin, please use the vibe-dice.bat batch file on Windows or the vibe-

dice.sh script file on UNIX/Linux. 

To access VIBE, select the VIBE tab. When the VIBE tab is selected, the “VIBE” menu located in the 

top menu bar is enabled. From then on, you can use VIBE in DICE. 

Note:  To start without the plugin, use the dice.bat/dice.sh batch files to launch DICE. 

For the time being, the VIBE plugin can only access the “LocalShared” database when copied on a local 

hard drive, or the “Local” database when DICE runs directly on the DVD. 

Note: Plugin instructions are not provided in this manual, see http://scale.ornl.gov/vibe/. 

http://scale.ornl.gov/vibe/
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10. TROUBLESHOOTING 

10.1. Known Problem(s) 

This table lists all known problems and their solutions: 

Problem description Solution 

Figures are displayed with a 

comma instead of a dot as the 

decimal separator or vice versa 

You can override your language settings to American-English 

by adding the following command line options to the dice.bat 

or dice.sh file: 

-Duser.language=en -Duser.country=us 

Refer to these pages for technical details: 

http://www.oracle.com/technetwork/java/javase/javase7locales-

334809.html or 

http://www.oracle.com/technetwork/java/javase/java8locales-

2095355.html  

DICE results tables contains 

strange characters (e.g. square 

boxes or question marks) 

This problem can stem from missing fonts. Try the following: 

On Microsoft Windows, select Add/Remove programs in the 

Control Panel. Be sure that the optional feature “Additional 

Fonts and Media Support” is installed on the local hard drive. To 

check that all fonts are installed, browse your Java home 

directory and the lib\fonts subdirectory. 

VIBE tab does not appear 

although I have VIBE correctly 

installed on my system 

Make sure you have used the dice_vibe.bat file to launch 

DICE (See Section 9). 

On some 4K display screens 

DICE may not scale properly. 

Try adjusting your system DPI scaling. There is currently no 

common solution to this problem. 

 

  

http://www.oracle.com/technetwork/java/javase/javase7locales-334809.html
http://www.oracle.com/technetwork/java/javase/javase7locales-334809.html
http://www.oracle.com/technetwork/java/javase/java8locales-2095355.html
http://www.oracle.com/technetwork/java/javase/java8locales-2095355.html
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10.2. Startup Problem(s) 

DICE cannot start if it cannot connect to any database.  If this occurs, you will obtain the following 

dialog: 

 

Figure 22. No Connection Dialog. 

If failing to connect to the NEA master database (see Section 3), first check if the NEA website is 

currently accessible (www.oecd-nea.org).  If you need to connect through an HTTP proxy, click on the 

“Setup HTTP proxy…” button to open the Settings dialog.  Restart DICE for the settings to take effect. 

If failing to connect to a local database (see Section 3), check that the data files exist on the media (DVD 

or computer) and that you have read access. 

If you still cannot connect to either database, please send an email message containing the error messages 

to dice@oecd-nea.org.  You can copy these messages to the clipboard by using the “Copy messages” 

button. 

 

10.2.1. Windows 

To track down start up problems on Windows, follow these instructions:  

1. Determine if you have a suitable Java environment.  

2. Open a command window (Start menu > Run…) then type cmd.  

3. In the Command Prompt window, issue the java –version command.  

4. If you see the following message, your computer does not have Java properly installed: 

http://www.oecd-nea.org/
mailto:dice@oecd-nea.org
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C:\>java -version  
'java' is not recognized as an internal or external command, 
operable program or batch file.  

If this is the case, check that the PATH environment variable is correctly set.  Alternatively, Sun 

Microsystems offers a web page to verify your Java installation at 

www.java.com/en/download/installed.jsp. 

You can download Java from www.java.com.  (You should use a JRE 1.8 version at a minimum).  Once 

this is done, go to the DICE\software folder and type the following command:  

java –jar Dice.jar  

DICE should now open.  If not, to request further help, if there are error messages in the console, right-

click in the title bar, choose menu “Select all”, then “Copy”, and send the text in the clipboard to the 

DICE developers (dice@oecd-nea.org) for assistance. 

10.2.2. Linux/UNIX 

To troubleshoot problems on Linux, follow the below instructions:  

First, make sure your Java installation is correct with the following command:  

java –version 

You may need to put the full path to your Java executable in the dice.sh script and make sure that it 

has execution rights. 

10.3. Speed Problem(s) 

The following tips will improve execution speed: 

 Copy the DVD onto your hard drive instead of running from the DVD drive 

 Connect to the NEA remote database 

 Narrow the search to a few evaluations before pressing the “Search !” button 

 Display only relevant columns in result views. 

10.4. Memory Problem(s) 

Java programs need to specify the maximum memory they can use.  With a Sun Microsystems Java 

Machine this setting must be set by command line (or in the BAT or SH file).  The memory limit used 

by DICE is set in the dice.bat file (or dice.sh for Linux): 

-Xmx512M 

The above option -Xmx512M specifies that DICE will take at most 512Mbytes of memory.  If you have 

more physical memory (e.g. 1GB, or more), you can edit this command line and replace the option -

Xmx512M with -Xmx1024M.  For example to allow DICE to use at most 1GB of memory, the 

dice.bat file should be: 

javaw -Xmx1024M -jar Dice.jar 

http://www.java.com/en/download/installed.jsp
http://www.java.com/
mailto:dice@oecd-nea.org
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10.5. Bug Report Dialog 

 

Figure 23. Bug Report Dialog. 

The “Bug report” dialog is shown when a problem occurs in the DICE software.  This dialog contains 

useful information for developers and allows you to send an automatic report to them. 

Clicking the button “Send bug report” will bring up a dialog allowing you to enter your name, email 

address, and explanatory text. 

Filling in these fields are optional but consider inputting your email address so that you can receive an 

answer.  

Note:  Your email address will not be used for any other purpose. 

The Bug report functionality can only detect a programming bug (i.e. misuse of software API).  

To submit a manual bug report or a software enhancement request, please send an e-mail to dice@oecd-

nea.fr.  Please include the following information: 

 Screen captures; 

 Your environment (Operating System and Java version); 

 DICE version. 

This information can be found in the “About” dialog (see Section 3.8). 

mailto:dice@oecd-nea.fr
mailto:dice@oecd-nea.fr


NEA/NSC/DOC(95)03/II 

DICE: User's Manual 

 

Revision:  11 Page 40 of 56 
Date:  September 30, 2021 

11. A GLOSSARY OF DICE TERMS FOR CRITICAL AND 
SUBCRITICAL MEASUREMENTS 

The user selects from a set of search criteria given in the search window to query the DICE database.  

As shown in Figure 1, the search parameters are grouped into 10 themes: 

 General items 

 Fuel 

 Moderator / coolant material 

 Cladding material 

 Reflector material 

 Neutron absorbing material 

 Separation material 

 Geometry 

 Benchmark keff and calculations 

 Energy, spectra, sensitivities 

The outcome or result of submitting a query is displayed in the “Result” window.  It may be noted that 

this window now includes an additional theme:  Fuel area composition, which has been inserted after 

the “Geometry” and before the “Energy and spectra” themes. 

Generally, items selected in the Search window, i.e., the search parameters, are then displayed in the 

Result window.  That is, in general the terms or parameters presented in the Search window can (and 

will) be displayed in both the Search and the Result windows.  However, there are some terms or 

parameters which, though not part of the search parameters, can be requested (displayed) in the result 

window and therefore appear only in the result window.  Good examples of this type of parameter 

include the items in the “Fuel area composition” theme, which are displayed only on the Result window.  

Additionally there exist only a very few unique cases where parameters specified in the Search window 

are not displayed in the Result window.  Therefore, it can be assumed by the reader that all of the 

following terms in the glossary appear in both the Search and the Result windows, except where 

explicitly noted to appear in only the Search window or only the Result window. 

The glossary items are now discussed below in the same order as the 12 themes shown in the Result 

window (Figure 24). 

Unless otherwise specified, for recent evaluations (written after 2008) the data were entered into DICE 

by copying information from an Excel spreadsheet provided by the evaluator(s).  For earlier evaluations, 

all the data were extracted from the Handbook and entered manually.  The data correspond to the 

benchmark models of experimental configurations described in Section 3, which can be different from 

the description of experimental configurations presented in Section 1. 

Parameters followed by an asterisk are displayed only in the Result window. 
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Figure 24. Partial View of the Result Window 
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11.1. General Items 

The data or parameters in this theme or group are provided for all evaluations. 

Identification 

A unique identifier for each benchmark evaluation that takes the form: 

Fissile Material – Physical Form – Spectrum – Three-Digit Numerical Identifier 

such as PU-MET-FAST-003 for fast, plutonium system in which the fissile material is in the form of a 

metal.  In the case of subcritical experiments, the above identifier string is preceded by ‘SUB-’, such as 

SUB-PU-MET-FAST-001 for subcritical measurements of metal plutonium systems with fast spectrum.  

This identifier is documented at the top of each page of the evaluation.  On the Search page this 

parameter may be set to “Critical,” “Subcritical,” or “Critical and Subcritical.” 

The subdivision into fast, intermediate, thermal, and mixed spectra systems depends upon the neutron 

energy range where the majority of the fissions occur.  In the Handbook, fast, intermediate, and thermal 

systems are defined as systems in which more than 50% of the fissions occur at energies > 100 keV, 

0.625 eV - 100 keV, and < 0.625eV, respectively.  Systems for which more than 50% of the fissions do 

not occur in any one of these three energy ranges are classified as “mixed” spectra systems.  Cross 

references are included in the ICSBEP Handbook and in DICE for experimental series containing data 

that may be categorized by more than one energy range.  For example, series MIX-MISC-FAST-001 is 

comprised of 11 experiments of which only three configurations (Cases 9, 10, and 11) are appropriately 

categorized as MIX-MISC-FAST systems.  The other configurations are categorized differently and 

presented in DICE under the identifiers shown in Table 1. 

Table 1.  Example of cross reference identifiers for configurations published in the Handbook under 

identifier MIX-MISC-FAST-001. 

Case # Identifier in DICE 

1, 2, 3 IEU-MET-FAST-017-001, -002, -003 

4, 5, 6 IEU-COMP-INTER-002-004, -005, -006 

7, 8 MIX-MET-FAST-015-007, -008 

9, 10, 11 MIX-MISC-FAST-001-009, -010, -011 

Acceptable/Not Acceptable 

Parameter indicating whether the evaluation of an experiment was determined by the ICSBEP to be 

acceptable (or not) for use as a critical or subcritical benchmark experiment.  That judgment is 

documented in Sections 1.1 and 2 of an evaluation.  Additionally, the total number of acceptable and 

not acceptable cases (indicated by “Number of cases”) for each evaluation is displayed (only) in the 

Results window.  For unacceptable configurations, data are provided only in theme “General Items.” 
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Evaluator/Internal/Independent Reviewer 

Names of evaluator(s) and internal and independent reviewer(s) as documented on the Title Page of each 

evaluation.  Additionally, the country with which they are associated is indicated for each evaluator 

and/or reviewer. 

Varying parameter(s) across cases 

Parameters of the experimental configurations that are varied for the cases within the evaluation to study 

the impact of the variation on criticality.  These are often identified in Section 1.1 of each evaluation. 

The varying parameters are:  absorber material, absorber material thickness, acid molarity, array 

configuration, array size (number of units), assembly configuration, fuel composition, fuel 

concentration, geometry, interstitial material, lattice pitch, mass of individual units, moderation degree, 

moderation level, not applicable (single case), position of rods, reflector location, reflector material, 

replacement material, separating material thickness, separation material, size of units, solution height, 

and temperature. 

Laboratory 

Laboratory or organization where the experiment or series of experiments was performed (as 

documented in Section 1.1).  In the Search window these are arranged by country, then laboratory or 

organization. 

Main Purpose 

Main purpose for performance of the experiment by the laboratory or organization.  This is often 

discussed in Section 1.1. 

The main purposes are: burnup credit, dry fuel storage, fuel fabrication, interaction, MOX applications, 

physics measurements, reflector test, reprocessing, solution storage, transportation and storage, waste 

matrix, and wet fuel storage. 

Title 

Title of the evaluation.  The title is given on the Title Page and repeated on the first page of the 

evaluation. 

Keywords 

A list of words that describe the evaluation as provided on the first page of the evaluation (e.g., 

acceptable, fuel type, geometry, moderation material, reflection material, unacceptable, etc.). 

Dates (evaluation and experiment) 

The year(s) when the experiment or series of experiments was performed (as documented in Section 1.1) 

as well as the most recent year when the evaluation was revised (if it has been revised) and approved 

(as documented in the footer of each page).  For the year(s) when the experiment or series of experiments 

was performed, a start date and end date are provided for each evaluation. 



NEA/NSC/DOC(95)03/II 

DICE: User's Manual 

 

Revision:  11 Page 44 of 56 
Date:  September 30, 2021 

Revision* 

The revision number of the evaluation (as documented in the footer of each page).  If the current 

evaluation is the original, this is indicated by a revision number zero. 

References 

A list of formally published documents that contain relevant information about the experiment.  These 

are provided in Section 5. 

Number of cases* 

Total number of evaluated configurations within a series including the configurations rejected by the 

ICSBEP (as documented in Sections 1.1 and 2). 

# of cases* 

Total number of acceptable configurations within a series that match the search criteria. 

Label* 

Identifying name/number of the experiment used in the evaluation, as indicated in the reference 

documents. 

Case Number* 

The sequential number of the configurations that are considered as acceptable benchmarks by the 

ICSBEP.  The case numbers may appear in Sections 1 and 2, but will always be identified clearly in 

Sections 3 and 4 of the evaluation. 

11.2. Fuel 

Fuel may be characterized by Fuel form/Fissile material, Fuel region, U and Pu weight percent, and/or 

Pu/(U+Pu) ratio.  Each is described below. 

Fuel form/Fissile material 

The data or parameters in this group are common to all the experiments. 

The chemical form of the fuel in the evaluation (i.e., compound, metal/alloy, and/or solution).  A list of 

fissile materials is given for each fuel form.  (The list of fissile materials provides information on the 

fissile nuclides or isotopes and their chemical form and gives more detail than the Fissile material used 

in the Identification). 

Fuel concentration (g/l)* 

Concentration of fissile material for homogeneous-fueled solution experiments.  This entry is left blank 

for experimental configurations other than solutions. 

http://en.wikipedia.org/wiki/Solution
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Fuel region 

List of isotopes contained in the fuel region, irrespective of their effect on reactivity of the benchmark 

model.  Note:  this list appears only in the Search window.  Isotopes selected in the fuel region can be 

used to filter the set of experiments obtained in the search, i.e., experiments appearing in the Result 

window. 

Fuel composition (wt%)* 

List of each isotope within the fuel and the corresponding weight percent. 

U and Pu weight percent 

Weight percents of the U and Pu isotopes.  Note:  this list appears only in the Search window.  Ranges 

of isotopic fractions in the fuel region can be specified and used to filter the set of experiments obtained 

in the search, i.e., experiments appearing in the Result window. 

Pu/(U+Pu) ratio 

Ratio of the sum of the atom-densities of the Pu isotopes to the sum of the atom-densities of the U and 

Pu isotopes.  This ratio is listed as “0” for cases where U is present without Pu and as “1” for cases 

where only Pu is present. 

The data for “Fuel region,” “Fuel composition,” “U and Pu atom percent,” and “Pu/(U+Pu) ratio” 

automatically generated using homogenized core atom-densities provided in balance files or fuel 

material atom-densities provided in Section 3.3. 

11.3. Moderator/Coolant 

The data or parameters in the below groups are provided for most moderated and/or cooled experiments 

within an evaluation and are periodically updated.  These values are provided in Section 3. 

Moderator/Coolant material 

Moderator – a material present in the system to reduce the energy of the neutrons. 

Coolant – a material in an assembly or reactor mock-up that represents/simulates a reactor coolant. 

“None” indicates that neither moderator nor coolant materials are present. 

The moderator/coolant materials are:  alcohol, beryllium, beryllium oxide, cellulose acetate plastic, 

graphite, lead, lithium, Lucite/Plexiglas, mercury, oil, polyethylene, polystyrene, sodium, Teflon, 

uranium hydride, water (heavy water), water (light water), wax and zirconium hydride. 

Vmod/Vfuel ratio* 

The Vmod/Vfuel ratio is limited to heterogeneous systems with fuel rod assemblies and plate type fuel. It 

refers to the ratio of moderator volume to fuel volume in the equivalent fuel cell (the volume of fuel 

clad is not included in either fuel or moderator).  If there is a hole in the fuel rod, its volume is excluded 

from the fuel volume. 

http://en.wikipedia.org/wiki/Fast_neutron
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Moderator to fuel ratio* 

Moderator-to-fuel atom-density ratio refers to the ratio of moderator atom-densities to heavy metal 

atom-densities in the homogenized core.  This information is not currently available for some moderated 

experiments, but is being updated as balance files are calculated. 

These data are automatically generated using homogenized core atom-densities provided in balance 

files or atom-densities provided in Section 3.3. 

Moderator to fissile ratio* 

Moderator-to-fissile atom-density ratio refers to the ratio of moderator atom-density to fissile-isotopes 

atom-density in the homogenized core.  This information is not currently available for some moderated 

experiments, but is being updated as balance files are calculated. 

These data are automatically generated using homogenized core atom-densities provided in balance 

files or atom-densities provided in Section 3.3. 

The data or parameters in the groups below (i.e., “Cladding material,” “Reflector material,” “Neutron 

absorbing material,” “Concentration,” and “Separation material”) are provided for each experiment 

within an evaluation, as appropriate (as documented in Section 3). 

11.4. Cladding Material 

The specific material of the layer covering the basic fuel unit that prevents radioactive fission fragments 

or fuel particles from escaping the fuel.  When cladding material is not present in an experimental 

configuration, this is indicated by “None.” 

The cladding materials are: aluminum, carbon steel, hastelloy, lacquer, nickel, niobium, plastic tape, 

polyethylene, stainless steel, Teflon, zircaloy, and zirconium-niobium alloy. 

11.5. Reflector Material 

The material of the region surrounding the core whose purpose is to return a portion of leaking neutrons 

to the core by scattering.  When reflector material is not present in an experimental configuration, this 

is indicated by “None.” 

The reflector materials are:  

 Aluminum materials: Aluminum, Aluminum Oxide , Duralumin (Al, Fe, Cu)  

 Beryllium materials: Beryllium, Beryllium Oxide 

 Borated materials: Borated Concrete, Borated Uranyl Nitrate (B, U, N, H, O), Borated Light 

Water, Borated Polyethylene, Boron  

 Cadmium  

 Carbon materials: Borated Concrete, Borated Polyethylene, Carbon Steel, Concrete, 

Graphite, Lucite/Plexiglas (C, H, O), Molybdenum Carbide, Oil (C, H), Paraffin (C, H), 

Polyethylene, Tungsten Carbide  

 Cobalt  

 Copper materials: Copper, Duralumin (Al, Fe, Cu), Ni-Cu-Zn Alloy  
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 Iron materials: Carbon Steel, Duralumin (Al, Fe, Cu), Iron, Stainless Steel (Fe, Cr, Ni)  

 Lead  

 Lithium Deuteride (Li, D, O)  

 Magnesium 

 Molybdenum materials: Molybdenum, Molybdenum Carbide  

 Nickel materials: Nickel, Ni-Cu-Zn Alloy  

 Poly materials: Borated Polyethylene, Polyethylene  

 Silicon Dioxide  

 Sodium 

 Steel materials: Carbon Steel, Stainless Steel (Fe, Cr, Ni)  

 Thorium  

 Titanium  

 Tungsten materials: Tungsten, Tungsten Carbide 

 Uranium materials: Borated Uranyl Nitrate (B, U, N, H, O), Depleted Uranium, Depleted 

Uranium Dioxide, Uranyl Nitrate, Highly Enriched Uranium, Natural Uranium, Uranium 

Dioxide 

 Vanadium  

 Water: Borated Light Water, Heavy Water (D, O), Lithium Deuteride (Li, D, O), Water  

11.6. Neutron Absorbing Material 

Neutron absorbing material with a large neutron absorption cross section, also called absorber or poison, 

which is inserted into the experimental configuration to study its effectiveness in lowering the reactivity 

of fuel and/or any material that lowers to a considerable degree the reactivity of the benchmark 

configuration, which are selected based on the percent of captures by isotope over core given in 

“Spectra” Section (Table 2).  Two lists of absorbing materials are provided:  solid absorbers in and 

soluble absorbers.  When neutron absorbing material is not present in an experimental configuration, 

this is indicated by “None.” 

The solid neutron absorbing materials are: 

 Aluminum materials: Aluminum ; Aluminum Oxide ; Boral (B, Al, Na, Si) 

 Borated materials:  Boraflex (B, CH2, Si) ; Boral (B, Al, Na, Si); Borated Concrete; Borated 

Glass (Pyrex) (B, Si); Borated Plaster (B, S, Ca, Fe); Borated Polyethylene; Borated 

Stainless Steel (B, Fe, Cr, Ni); Borax (B, Na); Boron; Boron Carbide (B4C); ZrB2 

 Cadmium 

 Copper 

 Depleted Uranium 

 Dysprosium Alloy (Dy, Ti) 

 Europium 

 Gadolinium Materials: Gadolinide Alloy (Gd, Ni, Cr, Mo), Gadolinium 

http://en.wikipedia.org/wiki/Neutron_absorber
http://en.wikipedia.org/wiki/Cross_section_(physics)
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 Graphite 

 Hafnium 

 Iron 

 Lead 

 Poly materials:  Boraflex (B, CH2, Si), Borated Polyethylene, PVC (CH2, Cl), Polyethylene, 

Polystyrene (C, H) 

 Rhenium 

 Rhodium 

 Samarium 

 Silicon materials: Borated Glass (Pyrex) (B, Si), Silicon Dioxide 

 Steel:  Borated Stainless Steel (B, Fe, Cr, Ni), Carbon Steel, Stainless Steel (Fe, Cr, Ni) 

 Thorium 

 Vermiculite (H, C, N, O)  

 Zirconium materials :  Zircaloy (Zr, Fe, Sn, Cr), ZrB2 

The soluble neutron absorbing materials are:  

 Boron 

 Cadmium 

 Fission Products2: Cesium, Europium, Rhodium, Samarium 

 Gadolinium 

Concentration (g/l)* 

Concentrations of soluble neutron absorbing materials are given and refer to the amount of absorber 

material in the solution. 

11.7. Separation Material 

Material that geometrically separates fuel units and/or fuel assemblies (see item below).  Typically, the 

materials are inserted into the experimental configuration specifically to study penetration of neutrons 

through them.  When separation material is not present in an experimental configuration, this is indicated 

by “None.” 

The separation materials are:  

 Air 

 Aluminum materials:  Aluminum, Boral (B, Al, Na, Si) 

 Beryllium materials:  Beryllium, Beryllium Oxide 

                                                      

2 If Fission Products are involved in the experiment they are always entered as absorbers. 

http://en.wikipedia.org/wiki/Neutron_absorber
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 Boron materials: Boraflex (B, CH2, Si), Boral (B, Al, Na, Si), Borated Concrete, Borated 

Glass (Pyrex) (B, Si), Borated Plastic Foam (B, C, H, O), Borated Polyethylene, Borated 

Stainless Steel (B, Fe, Cr, Ni), Foamglass (B, Si, Na, O) 

 Cadmium 

 Celotex (C, H, O) 

 Chromium 

 Concrete 

 Copper 

 Depleted Uranium 

 Gadolinium materials:  Gadolinide Alloy (Gd, Ni, Cr, Mo), Gadolinium 

 Graphite 

 Iron 

 Lead 

 Magnesium Oxide 

 Manganese 

 Molybdenum 

 Nb-Zr 

 Nickel 

 None 

 Plywood (C, H, O) 

 Poly materials:  Borated Polyethylene, PVC (CH2, Cl), Polyethylene, Polystyrene (C, H), 

Wax (C,H) 

 Silicon Dioxide 

 Steel materials:  Borated Stainless Steel (B, Fe, Cr, Ni), Carbon Steel, Stainless Steel (Fe, 

Cr, Ni) 

 Tantalum 

 Titanium 

 Tungsten 

 Vanadium 

 Water (Light Water) 

 Zircaloy materials:  Nb-Zr , Zircaloy (Zr, Fe, Sn, Cr), Zirconium 

The absorbing separation materials are also entered as “Neutron absorbing material” (See Section 9.6). 

11.8. Geometry 

Major geometry details are given for benchmark configurations provided in Section 3. 

If several benchmark models are available in Section 3, the geometry details for simplified model are 

provided in DICE.  
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The “Core geometry” and “Description for Complex/Mixed Geometry” are common to all the 

experiments within an evaluation. The data or search parameters “Fuel unit geometry,” “Number of 

fissile units,” “Pitch type,” and “Pitch size (cm)” are provided for each experiment within an evaluation 

unless not applicable to the experimental configuration.   

Core geometry 

Basic characteristics of the core geometry that indicates whether the core is simple or complex.  The 

core geometries are:   

 Array: Assemblies, Fuel Units  

 Infinite Media: Heterogeneous; Homogeneous  

 Single Fuel Unit. 

Fuel unit or Fuel unit geometry 

Geometry of the elementary fuel unit.  “Fuel unit” appears only as parameters to be selected on the 

Search window; “Fuel unit geometry” appears only on the Result window. 

The basic fuel units are: 

 Foil3 

 Intersecting Pipes 

 Micro-spheres (contained in): Spherical Pebbles 

 Mixed/Complex Geometries 

 Pellet 

 Plate(s)4:  Annular Plate(s), Curved Plate(s), Cylindrical Plate(s), Rectangular Plate(s) 

 Rod(s):  Annular Rod(s), Cylindrical Rod(s), Star Cross-Section Rod(s), 

 Solid Body (Shape): Cuboid, Cylinder, Hemisphere, Hexagonal Block, Sphere, Annulus 

 Tank(s):  Annular Tank(s), Cylindrical Tank(s), Cylindrical Slab Tank(s), Nested Annular 

Tank(s), Nested Cylindrical Tank(s), Rectangular Tank(s), Rectangular Slab Tank(s), 

Spherical Tank(s) 

Fuel Unit Description 

Word description of fuel unit. This is provided for some configurations of Mixed/Complex Geometries. 

Pitch type 

Type of lattice geometry.  The information in this section is available only for configurations with 

Mixed/Complex Geometry and/or Rods as Fuel Unit Geometry. 

                                                      

3 Metal in the form of very thin sheets. 

4 A thin, flat piece of tough material. 
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The pitch types are:  square and triangular. 

Pitch size (cm) 

Center-to-center distance of fuel units in the lattice.  The information in this section is available only for 

the configurations with Mixed/Complex Geometry and/or Rods as Fuel Unit Geometry. 

Number of fissile units 

Number of fuel units in an assembly.  The information in this section is available only if the core consists 

of assemblies or fuel units. 

11.9. Fuel Area Composition 

% Fissions* 

The percentage of fissions by isotope over the core region, as indicated in the corresponding Spectra file 

(see the “Spectra” link at the top of the first page of each evaluation). 

% Captures* 

The percentage of capture by isotope over the core region, as indicated in the corresponding Spectra file 

(see the “Spectra” link at the top of the first page of each evaluation). 

11.10. Energy and Spectra 

These data are 3-group and 30-group spectra and absorption data available in the ICSBEP Handbook 

(see the “Spectra” link at the top of the first page of each evaluation to see the corresponding Spectra 

file).  The details of calculations are reported in the section “Detailed Neutron Spectrum and Absorption 

Data (Criticality Alarm/ Shielding Benchmarks)” of the Handbook.  Spectra files are currently not 

available for some evaluations, but are being continuously added as the files are calculated. 

Energy of average neutron lethargy causing fission 

The energy corresponding to the average neutron lethargy causing fission, EALF (eV).  The average 

neutron lethargy causing fission is defined for group calculations by: 
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where m is the number of a physical zone inside the core; gu  is the midpoint of the gth lethargy group, 
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Average fission group energy 

The average neutron energy causing fission, AFGE (eV): 











m g

m

g

m

fg

m g

m

g

m

fggE

AFGE


 )(

, 

where Eg is the midpoint of the gth energy group, and other quantities are as previously defined. 

Flux distribution or Fission distribution or Capture distribution 

The percentage of the neutron flux, fissions, and captures, respectively, that occur in the fast (energy > 

100keV), intermediate (0.625eV  energy  100keV), and thermal  

(energy < 0.625eV) energy ranges. 

Neutron balance 

The percentage of fissions and captures by isotope over the core region.  This option to specify a range 

of fission- or capture-fractions by isotope in the query of experiments is provided only in the Search 

window. 

Neutron gas temperature 

The neutron gas temperature (Tn) is limited to configurations with a thermal neutron spectrum. For group 

calculations, Tn is defined as: 
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, T0 = 293.6 K, 0  is the cross section at E0 = 0.0253 eV (v = 2200 m/s, T = 293.6 
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g  is the neutron flux in the groups collapsed into the thermal group (E < 0.625 eV).  Thus: 
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where 
E g  EgEg1 . 

Average fission neutrons per neutron absorbed in the core 

The average number of fission neutrons produced per neutron absorbed in the core, (f/a). 



NEA/NSC/DOC(95)03/II 

DICE: User's Manual 

 

Revision:  11 Page 53 of 56 
Date:  September 30, 2021 

11.11. Benchmark keff and Uncertainty 

If several benchmark models are available, the benchmark-model keff and uncertainty are usually 

provided for a simplified model. 

keff 

The benchmark-model keff (as documented in Section 3.5) is the expected value of keff from a calculation 

using the benchmark model and from the measurement for an experiment with materials and geometry 

exactly as described by the benchmark model (as documented in Section 3). 

keff uncertainty (1σ) 

The uncertainty of keff of the benchmark model (as documented in Section 3.5) is the uncertainty of the 

adjustment of keff due to simplification of the model (from Section 3.1) combined with the uncertainty 

of keff due to uncertainties in experimental data (from Section 2) to obtain the final combined uncertainty. 

Currently only symmetrical uncertainties can be recorded in DICE. In case of asymmetrical uncertainties 

in the evaluated keff, the largest absolute uncertainty value is reported in DICE5.  

11.12. Calculations 

Calculated keff and Calculated keff uncertainty 

keff and the uncertainty in keff calculated with various codes and cross-section data sets as tabulated in 

Section 4.  The results are obtained for the benchmark-model specification(s) provided in Section 3.  

The specific code, cross section library, and benchmark-model label (as appropriate) are indicated for 

each calculation. 

If several benchmark models are available, the calculated keff and uncertainty can be provided for any of 

them and corresponds to calculation label (see definition below). 

The specific code, cross section library, and calculation label (as appropriate) are indicated for each 

calculation. 

C/E* 

Ratio of calculated keff to benchmark keff for the various codes and cross-section data sets as tabulated in 

Section 4 C/E values are provided for the benchmark-model keff values entered into DICE and the 

corresponding calculated keff values. 

Code name* 

The specific code(s) used to calculate the benchmark-model keff and keff uncertainty.  This list includes 

all codes used in the Handbook.  The version of the code is not indicated (for example, MCNP, KENO 

etc). 

                                                      

5 Known cases are the following: HEU-MET-FAST-101 
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Library* 

The specific cross-section library(ies) used for the benchmark-model keff and keff uncertainty calculations.  

This list includes all cross-section libraries currently employed by the codes used in the Handbook. 

Calculation label* 

Benchmark-model label, such as Simplified Model, Detailed Model, etc., as appropriate, or code name 

and version (for some configurations) is provided. 
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